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Overview
LevelOne’s FCS-1040v3(PoE)/WCS-2040v3(WLAN) is a high-performance network camera
featuring 10x zoom and pan/tilt functionality. The camera is designed for indoor surveillance
applications such
as retail stores, offices, and banks.
The built-in 10x motorized optical zoom module provides excellent depth of field when zoomed
in, displaying clear-cut images of near or distant objects. With 300-degree pan and 135-degree
tilt, the camera can achieve a wide range of view, giving users more comprehensive control
over the monitored site. The FCS-1040v3/WCS-2040v3 is incorporated with LevelOne’s selfdeveloped Bach SoC; therefore, users can benefit from the advantages of dual-codec video and
two-way audio. With support for simultaneous dual streaming, the camera allows users to view
MJPEG or MPEG-4 videos on multiple platforms such as web browsers or 3G cell phones.
LevelOne’s WCS-2040v3 supports wireless and FCS-1040v3 supports Power-over-Ethernet
connection, making installation easier and more cost-efficient. The free, standard, multi-lingual
16-channel recording software helps users to seamlessly set up an easy-to-use IP surveillance
system.

Read Before Use

The use of surveillance devices may be prohibited by law in your country. The Network Camera
is not only a high-performance web-ready camera but can also be part of a flexible surveillance
system. It is the user’s responsibility to ensure that the operation of such devices is legal and
complies with all privacy laws before installing this unit for its intended use.
It is important to first verify that all contents received are complete according to the Package
Contents listed below. Take note of the warnings in the Quick Installation Guide before the
Network Camera is installed; then carefully read and follow the instructions in the Installation
chapter to avoid damage due to faulty assembly and installation. This also ensures the product
is used properly as intended.
The Network Camera is a network device and its use should be straightforward for those
who have basic networking knowledge. It is designed for various applications including video
sharing, general security/surveillance, etc. The Configuration chapter suggests ways to best
utilize the Network Camera and ensure proper operations. For more creative and professional
developers, the URL Commands of the Network Camera section serves as a helpful reference
to customizing existing homepages or integrating with the current web server.

Package Contents

■ IP Camera
■ Power Adapter
■ Antenna (WCS-2040v3 only)
■ Ceiling Mount Brackets
■ Quick Installation Guide
■ CD Manual / Utility
■ A/V Cable
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Physical Description
Front panel
Lens
Built-in Microphone

Status LED

Rear panel

Antenna
(WCS-2040v3 only)

Microphone In
Ethernet 10/100
RJ45 Socket

AV Out
Recessed Reset Button

Power Cord Socket
General I/O
Terminal Block

External/Internal
Microphone Switch

General I/O Terminal Block
This Network Camera provides a general I/O terminal block which is used to connect external
input / output devices. The pin definitions are described below.
1: Power
2: Digital output
3: Digital input
4: Ground

Pin
1
2
3
4
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Name
Power
Digital output
Digital input
Ground

Specification
12VDC ± 5%, max. 1.5A
Max. 40VDC, max. 400mA, isolation 2kV
OPEN/Short-to-GND, isolation 2kV

Remarks
Max. rating 2A
Internal pull-up

DI/DO Diagram
Please refer to the following illustration for the connection method.

Status LED
The color of LED indicates the status of the Network Camera.
Status LED Color
Blinking red
Solid green
Steady green with blinking red
Steady green and red
Steady red with blinking green
Blinking red and green

Description
Power is being supplied to the Network Camera.
The Network Camera is booting up.
The Network Camera is trying to obtain an IP address.
An IP address is successfully assigned to the Network Camera.
The Network Camera is working.
During firmware upgrade.
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Hardware Reset

The reset button is used to reset the system or restore the factory default settings. Sometimes
resetting the system can return the camera to normal operation. If the system problems remain
after rebooting, restore the factory settings and install again.
Reset: Press and release the recessed reset button with a paper clip or thin object. Wait for the
Network Camera to reboot.
Restore: Press and hold the recessed reset button until the status LED rapidly blinks red and
green simultaneously. Note that all settings will be restored to factory default.
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Installation

Hardware Installation
Follow the steps below to install the Network Camera to the ceiling:
1. Attach ceiling mount bracket A to the Network Camera and secure it with two small screws.
2. Drill three pilot holes into the ceiling; hammer the plastic anchors into the holes.
3. Fasten ceiling mount bracket B to the ceiling with three screws.
4. Slide the Network Camera into ceiling mount bracket B.
5. Secure the ceiling mount bracket A and B with a small screw.

NOTE
► If you want to intall the Network Camera on
the wall, please use the wall mount bracket
(optional, not included in the package).

► Keep away from interference source to
make sure performance integrate, and
avoid snow or moiré patterning.
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Network Deployment
Setup the Network Camera over the Internet
This section explains how to configure the Network Camera over an Internet connection.
1. If you have external devices such as sensors and alarms, connect them to the general I/O
terminal block.
2. Connect the camera to a switch via Ethernet cable.
3. Connect the supplied power cable from the Network Camera to a power outlet.
1: Power
2: Digital ouput
3: Digital input
4: Ground

3

1

2
Ethernet Switch

There are several ways to set up the Network Camera over the Internet. The first way is to set
up the Network Camera behind a router. The second way is to utilize a static IP. The third way is
to use PPPoE.
Internet connection via a router
Before setting up the Network Camera over the Internet, make sure you have a router and follow
the steps below.
1. Connect your Network Camera behind a router, the Internet environment is illustrated below.
Regarding how to obtain your IP address, please refer to Software Installation on page 11 for
details.
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2. In this case, if the Local Area Network (LAN) IP address of your Network Camera is
192.168.0.3, please forward the following ports for the Network Camera on the router.
■ HTTP port
■ RTSP port
■ RTP port for audio
■ RTCP port for audio
■ RTP port for video
■ RTCP port for video
If you have changed the port numbers on the Network page, please open the ports accordingly
on your router. For information on how to forward ports on the router, please refer to your
router’s user’s manual.
3. Find out the public IP address of your router provided by your ISP (Internet Service Provider).
Use the public IP and the secondary HTTP port to access the Network Camera from the
Internet. Please refer to Network Type on page 32 for details.
Internet connection with static IP
Choose this connection type if you are required to use a static IP for the Network Camera.
Please refer to LAN on page 32 for details.
Internet connection via PPPoE (Point-to-Point over Ethernet)
Choose this connection type if you are connected to the Internet via a DSL Line. Please refer to
PPPoE on page 33 for details.
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Set up the Network Camera through Power over Ethernet (PoE) (FCS-1040v3 only)
When using a PoE-enabled switch
The Network Camera is PoE-compliant, which allows it to be powered via a single Ethernet
cable. If your switch/router supports PoE, refer to the following illustration to connect the
Network Camera to a PoE-enabled switch/router.

power + data transmission

PoE Switch
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When using a non-PoE switch
If your switch/router does not support PoE, use a PoE power injector (optional) to connect
between the Network Camera and a non-PoE switch/router.

PoE Power Injector
(optional)

Non-PoE Switch
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Software Installation
The following are steps for the software installation.

Note: The default user name is root and the password is blank
How to Use Installation Wizard
Installation
The following are steps for the software installation.
STEP. 1 Put the Installation disk into the CD-ROM drive, and the installation should start
automatically. If the installation does not start, click on “Start” on the lower left corner of your
screen, open “My Computer” and double click on the CD-ROM icon. The Installation Wizard
Installation Window will appear.
STEP. 2 There are links on this page, including Install Software, User’s Manual and Customer
Homepage. Click on “Install Software” to enter Install Software page.

STEP. 3 There are links on this page, including Installation Wizard, User’s Manual and
Surveillance Software. Click on “Installation Wizard” to launch the setup program.

Destination Location for Installation
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STEP 4: After clicking “Install” button, the install system will install the Installation Wizard to your
computer, and a progress bar will display on the dialog. After completed the installation, please
click on the “Close” button.

Completed

Using Installation Wizard
User Interface

Once you run the Installation Wizard, after a short searching time, you will see the user interface
as below. “Manual Setup” button, a “Refresh Devices” button and an arrow button on the left
panel of your user interface. When you click on the arrow button, you will see more advanced
functional buttons: “Firmware Upgrade”, “Restore Default” and “About IW”. You can select
your device by double-clicking it in the device list. The left three buttons (“Manual Setup”,
“Firmware Upgrade”, and “Restore Default”) won’t be enabled until you select at least one
device.

Installation Wizard allows you to setup one device at one time and upgrade multiple devices
(of the same model) at the same time. If you selected different models, then the “Firmware
Upgrade” button would be disabled.
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Installation wizard allows you to setup or upgrade multiple devices (of the same model) at the
same time. If you selected different models, then the buttons will be disabled. There are five
buttons on the bottom of the main page, and five buttons on the left panel of the main page.

Buttons
Click on this button to clean up the device list and search all devices on
the within the same subnet again. It will take about 5 seconds.

Click on this button to modify the settings of the selected devices. For
more detail, please refer to 0 Setup.
Click on this button to upgrade the firmware of the selected devices. For
more detail, please refer to 0 Upgrade.

Click on this button to reset the selected devices to default settings.

Click on this button to get information about the Installation Wizard.

Manual Setup
When you select one device in the selection list, the “Manual Setup” button will be enabled.
Click on it to modify the settings of the selected device. After clicked on the “Manual Setup”
button, Installation Wizard would try to connect to the selected device.
The default Administrator’s password is blank and the Network Camera initially will not ask for
any password. If the authentication is failed, there would be a pop-up dialog window to ask for
correct password. If you failed three times, the Installation Wizard would show you a warning
dialog window and abort the connecting to the selected device.

Authentication Dialog Window
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Authentication error

System Setting

After connected to the selected device, the Installation Wizard will switch to system setting page
as below.

System setting page
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Click on this button to cancel the setup progress.
Click on this button to keep the present setting and go to the next page.

Change Host Name

The “Hostname” is used for the homepage title of main page and is displayed as the title in the
video window of the main page. The maximum string length is 40 characters or 20 characters
in double-byte-character-systems like Chinese or Japanese. But for some models supported
Unicode, the maximum string length depends on the characters you input, and it may less than
20 characters.

Change root password

To change the administrator’s password, type the new password in both “Password” and
“Confirm Password” text boxes identically. What is typed will be displayed as asterisks for
security purposes. The maximum password depends on the server you connected.

Adjust date and time

Date/Time setup
There are three ways to adjust system date and time:
1.
“Synchronize with computer time”: The easiest way is to make device synchronized
with your computer time.
2.
“Set date and time manually”: Set the date and time manually by entering new values.
Notice the format in the related field while typing.
3.
“Synchronize to network time server automatically”: Make device automatically
synchronize with timeservers over the Internet every hour.
If you want to keep the current date and time, please choose “Keep current date and time”.
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Network Setting

The Installation Wizard can help you to setup the network connection with LAN or PPPoE. After
you clicked on the “Next” button on the System page, the Installation Wizard would lead you to
the PPPoE setting page. If you want to connect your server to Internet via PPPoE, please click
on “Yes” to start the PPPoE setting process, or click on “No” to invoke the LAN setting.

Choosing the network type

PPPoE Setting

Network setting for PPPoE
If you click on “Yes” in the “Network Type” dialog window, you will be led to the PPPoE setting
page. In this page, you can input the “PPPoE username” and “PPPoE password” provided by
your ISP, and then the server will be set to PPPoE mode rather than LAN mode when the setup
is completed. If you don’t know the account information, please contact your ISP. After inputting
the account information, please click on the “Next” button to continue your next step.
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LAN Setting
If you click on “No” in the “Network Type” dialog window, you will be led to the Network setting
page. In this page, you can change the server’s IP address, subnet mask, default gateway,
primary DNS server, secondary DNS and DHCP server. Please refer to the below page.

Network Setting for LAN
You could set up the network with DHCP or fixed IP:
1.DHCP: Check the “Get IP by DHCP Server automatically” will force the device to renew its
IP address whenever it reboots, and the related network configuration is provided by the DHCP
server.
2.Fixed IP: If you want the device to use a fixed IP, please uncheck the “Get IP by DHCP Server automatically” checkbox and assign a valid IP address, subnet mask, default gateway and
DNS server for the device.

Mobile Access
After finished the DDNS setting and click on the Next button. If your device supports mobile
viewer and you want to access the device by mobile phone, you can enable the “Mobile Access”
by clicking on the Yes button. The Installation Wizard will do some setting for mobile viewing
toward the device:
1.Video: The video codec will be set to MPEG-4, and the resolution will be set to 176x144 pixels.
2.Audio: The audio codec will be set to AAC.
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Mobile Access

Apply to selected device
After configuring all the settings, the apply page will show up. Click on “Apply” button to apply
the changes to the selected device or click on “Back” button to go back to the previous page and
modify the setting again.

Apply page
When you click on the “Apply”, it will start to update your settings to server.

Upgrade
When you select one device or multiple devices (of the same model), the “Firmware Upgrade”
button will be enabled. Click on it to upgrade the firmware of the selected device(s). After click
on the “Firmware Upgrade” button, Installation Wizard will try to connect the selected device(s)
and lead you to the firmware upgrade page.
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Click on the “Firmware Upgrade”

Device Information
After connected to the selected device(s), it would display as below. If you select more than one
device, then the device information will show all the selected devices. You can switch to the
server info by click on the tab control.

Device information
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Multiple devices information

Firmware Information

The selected firmware information will show the information about the file that you selected.
Firmware version: The version number of the selected firmware.

Select Firmware

You can use the “Select firmware” button to browse the file that you want upgrade onto the selected device(s). After selected the file, Installation Wizard will check whether the file you selected is correct. If it’s the correct version, then the package information will display the information
about the file and enable the “Start Upgrade” button. Therefore you can click on the button to
upgrade the firmware. If not, then it will be a pop-up warning message.

Select firmware
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Firmware Information

Warning message for unmatched firmware
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Start Upgrade

Clicking on the “Start Upgrade” button to upgrade the firmware of the selected device(s), and
it will be a pop-up dialog window to show the progress of the upgrading process. Usually, it will
take about 5 to 10 minutes to finish the firmware upgrading. It depends on your server model
and network bandwidth. We recommend you do the upgrade process in wired LAN environment
rather than PPPoE or wireless environment.

Update progress

After the upgrade process had been done, you could see the dialog window as below.
Please click on the button “OK” to finish it.

Upgrade Done
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Accessing the Network Camera
This chapter explains how to access the Network Camera through web browsers, RTSP players,
3GPP-compatible mobile devices, and LevelOne recording software.

Using Web Browsers
Use Installation Wizard 2 (IW2) to access to the Network Cameras installed on the LAN.
If your network environment is not the LAN, follow these steps to access the Network Camera:
1. Launch your web browser (eg. Microsoft® Internet Explorer, Mozilla Firefox, or Netscape).
2. Enter the IP address of the Network Camera in the address field. Press Enter.
3. The live video will be displayed in your web browser.
4. If this is the first time installing the LevelOne network camera, an information bar will pop up
as shown below. Follow the instructions to install the required plug-in on your computer.

NOTE
► For Mozilla Firefox or Netscape users, your browser will use Quick Time to stream the live
video. If you do not have Quick Time on your computer, please install it first, then launch the
web browser.
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► By default, the Network Camera is not password-protected. To prevent unauthorized access,
it is highly recommended to set a password for the Network Camera.
For more information about how to enable password protection, please refer to Security on
page 26.
► If you see a dialog box indicating that your security settings prohibit running ActiveX ®
Controls, please enable the ActiveX ® Controls for your browser.
1. Choose Tools > Internet Options > Security > Custom Level.

2. Look for Download signed ActiveX ® controls; select Enable or Prompt. Click OK.

3. Refresh your web browser, then install the Active X ® control. Follow the instructions to
complete installation.
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Using RTSP Players
To view the MPEG-4 streaming media using RTSP players, you can use one of the following
applications that support RTSP streaming.
Quick Time Player
Real Player
VLC media player
1. Launch the RTSP player.
mpegable
Player
2. Choose
File > Open
URL. A URL dialog box will pop up.
3. The address format is rtsp://<ip address>:<rtsp port>/<RTSP streaming access name for
pvPlayer
stream1 or stream2>
As most ISPs and players only allow RTSP streaming through port number 554, please set the
RTSP port to 554. For more information, please refer to RTSP Streaming on page 41.
For example:

4. The live video will be displayed in your player.
For more information on how to configure the RTSP access name, please refer to RTSP
Streaming on page 41 for details.
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Using 3GPP-compatible Mobile Devices
To view the streaming media through 3GPP-compatible mobile devices, make sure the Network
Camera can be accessed over the Internet. For more information on how to set up the Network
Camera over the Internet, please refer to Setup the Network Camera over the Internet on page 8.
To utilize this feature, please check the following settings on your Network Camera:
1. Because most players on 3GPP mobile phones do not support RTSP authentication, make
sure the authentication mode of RTSP streaming is set to disable.
For more information, please refer to RTSP Streaming on page 41.
2. As the the bandwidth on 3G networks is limited, larger video sizes are not available. Please
set the video and audio streaming parameters as listed below.
For more information, please refer to Audio and Video on page 51.

3. As most ISPs and players only allow RTSP streaming through port number 554, please set
the RTSP port to 554. For more information, please refer to RTSP Streaming on page 41.
4. Launch the players on 3GPP-compatible mobile devices (ex. Real Player).
5. Type the following URL commands in the player.
The address format is rtsp://<public ip address of your camera>:<rtsp port>/<RTSP streaming
access name for stream1 or stream2>.
For example:
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Using LevelOne Recording Software
The product software CD also contains LevelOne’s recording software, allowing simultaneous
monitoring and video recording for multiple Network Cameras. Please install the recording
software, then launch the program to add the Network Camera to the Channel list. For detailed
information about how to use the recording software, please refer to the user’s manual of the
software or download the manual from http://www.LevelOne.com.
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Main Page
This chapter explains the layout of the main page. It is composed of the following sections:
LevelOne INC. Logo, Host Name, Camera Control Area, PTZ Control Panel, Configuration Area,
and Live video window.

LevelOne INC. Logo
Click this logo to visit the LevelOne website.

Host Name

The host name can be customized to fit your needs. For more information, please refer to System on page 24.

Camera Control Area
Video Stream: This Network Camera supports MJPEG or MPEG-4 dual streams simultaneously. You can
select either one for live viewing.
Digital Output: Click to turn the digital output device on or off.

PTZ Control Panel
Left

Up
Return to Home Position
Right

Down
Zoom Out
Focus Near
Close

Zoom In
Focus Far
Open

Auto Focus
Auto Iris

Start to Auto Patrol

Start to Auto Pan
Stop Auto Panning/patrolling

User's Manual - 29

Pan: Click this button to start the auto pan. When the current position is Home or on the left side of
Home, the camera starts panning from the current position to the left-most position, then to the rightmost position, and finally backward to the original position. When the current position is on the right side
of Home, the camera starts panning from the current position to the right-most position, then to the leftmost position, and finally backward to the original position.
Stop: Click this button to stop the Auto Pan and Auto Patrol functions.
Patrol: Once the Administrator has determined the list of preset positions, click this button to command
the camera to patrol among those positions on the Patrol List. For more information, please refer to
Camera Control on page 59.
Pan /Tilt /Zoom /Focus speed: Adjust the speed of pan/ tilt/ zoom/ focus.
Pan speed
-5
-4
-3
-2
-1
0
1
2
3
4
5

Tilt speed
-5
-4
-3
-2
-1
0
1
2
3
4
5

Zoom speed
-5
-4
-3
-2
-1
0
1
2
3
4
5

Focus speed
-5
-4
-3
-2
-1
0
1
2
3
4
5

Slower

Faster

Configuration Area

Client Settings: Click this button to access the client settings page. For more information, please refer to
Client Settings on page 21.
Configuration: Click this button to access the configuration page of the Network Camera. It is suggested
that a password be applied to the Network Camera so that only the administrator can configure the
Network Camera. For more information, please refer to Configuration on page 23.
Language: Click this button to choose a language for the user interface. Language options are available
in: English, Deutsch, Español, Français, Italiano, 日本語, Português, 簡体中文, and 繁體中文.

Live Video Window
■ The following window is displayed when the video mode is set to MPEG-4:
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Video Title: The video title can be configured. For more information, please refer to Video Settings on
page 51.
MPEG-4 Protocol and Media Options: The transmission protocol and media options for MPEG-4 video
streaming. For further configuration, please refer to Client Settings on page 21.
Time: Display the current time. For further configuration, please refer to Video Settings on page 51.
Title and Time: The video title and time can be stamped on the streaming video. For further configuration,
please refer to Video Settings on page 51.
Video and Audio Control Buttons: Depending on the Network Camera model and Network Camera
configuration, some buttons may not be available.
Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.bmp) format.
Digital Zoom: Click and uncheck “Disable digital zoom” to enable the zoom operation. The navigation
screen indicates the part of the image being magnified. To control the zoom level, drag the slider bar. To
move to a different area you want to magnify, drag the navigation screen image.

Pause: Pause the transmission of the streaming media. The button becomes the
after clicking the Pause button.
Stop: Stop the transmission of the streaming media. Click the
transmission.

Resume button

Resume button to continue

Start MP4 Recording: Click this button to record video clips in MP4 file format. Press the
Stop MP4 Recording button to end recording. When you exit the web browser, video recording stops
accordingly. To specify the storage destination and the file name, please refer to MP4 Saving Options on
page 22 for details.
Volume: If the
local computer.

Mute function is not activated, move the slider bar to adjust the volume on the

Mute: Turn off the volume on the local computer. The button becomes the
clicking the Mute button.

Audio On button after

Talk:: Click this button to talk to people around the Network Camera. Audio will project from
again to end talking
the external speaker connected to the Network Camera. Click this button
transmission.
Mic Volume: When the
Mute function is not activated, move the slider bar to adjust the
microphone volume on the local computer.
Mute: Turn off the
Mic volume at local computer. The button becomes the
after clicking the Mute button.

Mic On button

Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.
User's Manual - 31

Go to: Once the Administrator has determined the list of preset positions, you can aim the camera using
this command. For more information, please refer to Camera Control on page 59.

■ The following window is displayed when the video mode is set to MJPEG:

Video Title: The video title can be configured. For more information, please refer to Video Settings on
page 51.
Time: Display the current time. For more information, please refer to Video Settings on page 51.
Title and Time: The video title and time can be stamped on the streaming video. For more information,
please refer to Video Settings on page 51.
Video and Audio Control Buttons: Depending on the Network Camera model and Network Camera
configuration, some buttons may not be available.
Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.bmp) format.
Digital Zoom: Click and uncheck “Disable digital zoom” to enable the zoom operation. The navigation
screen indicates the part of the image being magnified. To control the zoom level, drag the slider bar. To
move to a different area you want to magnify, drag the navigation screen image.

Start MP4 Recording: Click this button to record video clips in MP4 file format. Press the
Stop MP4 recording button to end recording. When you exit the web browser, video recording stops
accordingly. To specify the storage destination and file name, please refer to MP4 Saving Options on
page 22 for details.
Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.
Go to: Once the Administrator has determined the list of preset positions; you can aim the camera using
this command. For more information, please refer to Camera Control on page 59.
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Client Settings
This chapter explains how to select the stream transmission mode and saving options on the
local computer. When finished with the settings on this page, click Save on the bottom of the
page to enable the settings.
MPEG-4 Media Options

Select whether to stream video or audio data or both. This is enabled only when the video mode is set to
MPEG-4.

MPEG-4 Protocol Options

Depending on your network environment, there are four transmission modes for MPEG-4 streaming:
UDP unicast: This protocol allows for better real-time audio and video streams. However, network
packets may be lost due to network burst traffic and images may be broken. Activate the UDP connection
when occasions require time-sensitive responses and the video quality is less important. Note that each
unicast client connecting to the server takes up additional bandwidth and the Network Camera allows up
to ten simultaneous accesses.
UDP multicast: This protocol allows multicast-enabled routers to forward network packets to all clients
requesting streaming media. This helps to reduce the network transmission load of the Network Camera
while serving multiple clients at the same time. Note that to utilize this feature, the Network Camera must
be configured to enable multicast streaming at the same time. For more information, please refer to
RTSP Streaming on page 41.
TCP: This protocol guarantees the complete delivery of streaming data and thus provides better video
quality. However, the real-time effect is not as good as that of the UDP protocol.
HTTP: This protocol allows for the same transmission quality as the TCP protocol without needing to
open specific ports for streaming under some network environments. Users inside a firewall can utilize
this protocol to allow streaming data through.
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MP4 Saving Options

Users can record live video as they are watching by clicking
Here, you can specify the storage destination and file name.

Start MP4 Recording on the main page.

Folder: Specify the storage destination for the recorded video files.
File name prefix: Enter the text that will be appended to the front of the video file name.
Add date and time suffix to the file name: Select this option to append the date and time to the end of the
file name.
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Configuration
Click Configuration on the main page to enter the camera setting pages. Note that only
Administrators can access the configuration page.
LevelOne offers an easy-to-use user interface that helps you set up your network camera with
minimal effort. To simplify the setting procedure, two types of user interfaces are available:
Advanced Mode for professional users and Basic Mode for entry-level users. Some advanced
functions (HTTPS/ Access list/ Homepage layout/ Application/ Recording/ System log/ View
parameters) are not displayed in Basic Mode.
If you want to set up advanced functions, please click [Advanced Mode] on the bottom of the
configuration list to quickly switch to Advanced Mode.
In order to simplify the user interface, the detailed information will be hidden unless you click on
the function item. When you click on the first sub-item, the detailed information for the first subitem will be displayed; when you click on the second sub-item, the detailed information for the
second sub-item will be displayed and that of the first sub-item will be hidden.
The following is the interface of the Basic Mode and the Advanced Mode:
Basic Mode
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Advanced Mode

Each function on the configuration list will be explained in the following sections. Those functions that are
displayed only in Advanced Mode are marked with Advanced Mode . If you want to set up the advanced
functions, please click [Advanced Mode] on the bottom of the configuration list to quickly switch over.

System
This section explains how to configure the basic settings for the Network Camera, including
System, System Time, and DI/DO. When completed with the settings on this page, click Save at
the bottom of the page to enable the settings.
System

Host name: Enter the desired name for the Network Camera. The text will be displayed at the top of the
main page.
Turn off the LED indicators: If you do not want to let others know that the network camera is in operation,
you can select this option to turn off the LED indicators.
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System Time

Keep current date and time: Select this option to preserve the current date and time of the Network
Camera. The Network Camera’s internal real-time clock maintains the date and time even when the
system power is turned off.
Sync with computer time: Select this option to synchronize the date and time of the Network Camera with
the local computer. The read-only date and time of the PC is displayed when updated.
Manual: The administrator can enter the date and time manually. Note that the date and time format is
[yyyy/mm/dd] and [hh:mm:ss].
Automatic: The Network Time Protocol is a protocol which synchronizes computer clocks by periodically
querying an NTP Server.
NTP server: Assign the IP address or domain name of the time-server. Leaving the text box blank
connects the Network Camera to the default time servers.
Update interval: Select to update the time using the NTP server on an hourly, daily, weekly, or monthly
basis.
Time zone Advanced Mode : Select the appropriate time zone from the list. If you want to upload
Daylight Savings Time rules on the Maintenance page, please refer to Upload / Export Daylight Saving
Time Configuration File on page 84 for details.

DI and DO

Digital input: Select High or Low to define the normal status for the digital input. The Network Camera
will report the current status.
Digital output: Select Grounded or Open to define normal status for the digital output. The Network
Camera will show whether the trigger is activated or not.

User's Manual - 37

Security
This section explains how to enable password protection and create multiple accounts.
Root Password

The administrator account name is “root”, which is permanent and can not be deleted. If you want to add
more accounts in the Manage User column, please set a password for the “root” account first.
1. Type the password in both text boxes, then click Save to enable password protection.
2. A window will be prompted for authentication; type the correct user’s name and password in their
respective fields to access the Network Camera.

Manage Privilege Advanced Mode

Digital Output & PTZ control: You can modify the manage privilege of operators or viewers. Check or
uncheck the item, then click Save to enable the settings. If you give Viewers the privilege, Operators will
also have the ability to control the Network Camera through the main page. (Please refer to Main Page
on page 17.)
Allow anonymous viewing: If you check this item, any client can access the live stream without entering a
User ID and Password.

Manage User

Administrators can add up to 20 user accounts.
1. Input the new user’s name and password.
2. Select the privilege level for the new user account. Click Add to enable the setting.
Access rights are sorted by user privilege (Administrator, Operator, and Viewer). Only administrators
can access the Configuration page. Operators cannot access the Configuration page but can use the
URL Commands to get and set the value of parameters. For more information, please refer to URL
Commands for the Network Camera on page 87. Viewers access only the main page for live viewing.
Here you also can change a user’s access rights or delete user accounts.
1. Select an existing account to modify.
2. Make necessary changes and click Update or Delete to enable the setting.
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HTTPS (Hypertext Transfer Protocol over SSL)

Advanced Mode

This section explains how to enable authentication and encrypted communication over SSL
(Secure Socket Layer). It helps protect streaming data transmission over the Internet on higher
security level.
Enable HTTPS

Check this item to enable HTTPS communication, then select a connection option: "HTTP & HTTPS"
or "HTTPS only". Note that you have to create and install a certificate first in the second column before
clicking the Save button.

Create and Install Certificate Method
Before using HTTPS for communication with the Network Camera, a Certificate must be created first.
There are three ways to create and install a certificate:
Create self-signed certificate automatically
1. Select this option.
2. In the first column, check Enable HTTPS secure connection, then select a connection option: “HTTP
& HTTPS” or “HTTPS only”.
3. Click Save to generate a certificate.
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4. The Certificate Information will automatically de displayed in the third column as shown below. You can
click Property to view detailed information about the certificate.

5. Click Home to return to the main page. Change the address from “http://” to “https://“ in the address
bar and press Enter on your keyboard. Some Security Alert dialogs will pop up. Click OK or Yes to
enable HTTPS.
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Create self-signed certificate manually
1. Select this option.
2. Click Create to open a Create Certificate page, then click Save to generate the certificate.

3. The Certificate Information will automatically be displayed in the third column as shown below. You
can click Property to see detailed information about the certificate.

Create certificate and install : Select this option if you want to create an official certificate issued by
a CA (Certificate Authority).
1. Select this option.
2. Click Create to open the Create Certificate page, then click Save to generate the certificate.
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3. If you see the following Information bar, click OK and click on the Information bar on the top of the
page to allow pop-ups.

4. The pop-up window shows an example of a certificate request.
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5. Look for a trusted certificate authority that issues digital certificates. Enroll the Network Camera. Wait
for the certificate authority to issue a SSL certificate; click Browse... to search for the issued certificate,
then click Upload in the second column.

NOTE
► How do I cancel the HTTPS settings?
1. Uncheck Enable HTTPS secure connection in the first column and click Save; a warning dialog will
pop up.
2. Click OK to disable HTTPS.

3. The webpage will redirect to a non-HTTPS page automatically.
► If you want to create and install other certificates, please remove the existing one. To remove the
signed certificate, uncheck Enable HTTPS secure connection in the first column and click Save.
Then click Remove to erase the certificate.
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Network
This section explains how to configure a wired network connection for the Network Camera.
Network Type

LAN

Select this option when the Network Camera is deployed on a local area network (LAN) and is intended
to be accessed by local computers. The default setting for the Network Type is LAN. Rememer to click
Save when you complete the Network setting.
Get IP address automatically: Select this option to obtain an available dynamic IP address assigned by
the DHCP server each time the camera is connected to the LAN.
Use fixed IP address: Select this option to manually assign a static IP address to the Network Camera.

1. You can make use of LevelOne Installation Wizard 2 on the software CD to easily set up the Network
Camera on LAN. Please refer to Software Installation on page 11 for details.
2. Enter the static IP, Subnet mask, Default router, and Primary DNS provided by your ISP.
Enable UPnP presentation: Select this option to enable UPnPTM presentation for your Network Camera
so that whenever a Network Camera is presented to the LAN, shortcuts of connected Network Cameras
will be listed in My Network Places. You can click the shortcut to link to the web browser. Currently,
UPnPTM is supported by Windows XP or later. Note that to utilize this feature, please make sure the
UPnPTM component is installed on your computer.
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Enable UPnP port forwarding: To access the Network Camera from the Internet, select this option to
allow the Network Camera to open ports on the router automatically so that video streams can be sent
out from a LAN. To utilize of this feature, make sure that your router supports UPnPTM and it is activated.

PPPoE (Point-to-point over Ethernet)

Select this option to configure your Network Camera to make it accessible from anywhere as long as
there is an Internet connection. Note that to utilize this feature, it requires an account provided by your
ISP.
Follow the steps below to acquire your Network Camera’s public IP address.
1. Set up the Network Camera on the LAN.
2. Go to Home > Configuration > Application > Server Settings (please refer to Server Settings on page
71) to add a new email or FTP server.
3. Go to Configuration > Application > Media Settings (please refer to Media Settings on page 74). Select
System log so that you will receive the system log in TXT file format which contains the Network
Camera’s public IP address in your email or on the FTP server.
4. Go to Configuration > Network > Network Type. Select PPPoE and enter the user name and password
provided by your ISP. Click Save to enable the setting.

5. The Network Camera will reboot.
6. Disconnect the power to the Network Camera; remove it from the LAN environment.

NOTE
► If the default ports are already used by other devices connected to the same router, the Network
Camera will select other ports for the Network Camera.
► If UPnP TM is not supported by your router, you will see the following message:
Error: Router does not support UPnP port forwarding.
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► Steps to enable the UPnP TM user interface on your computer:
Note that you must log on to the computer as a system administrator to install the UPnP TM
components.
1. Go to Start, click Control Panel, then click Add or Remove Programs.

2. In the Add or Remove Programs dialog box, click Add/Remove Windows Components.

3. In the Windows Components Wizard dialog box, select Networking Services and click Details.
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4. In the Networking Services dialog box, select Universal Plug and Play and click OK.

5. Click Next in the following window.

6. Click Finish. UPnP TM is enabled.
► How does UPnP TM work?
UPnP TM networking technology provides automatic IP configuration and dynamic discovery of devices
added to a network. Services and capabilities offered by networked devices, such as printing and file
sharing, are available among each other without the need for cumbersome network configuration. In
the case of Network Cameras, you will see Network Camera shortcuts under My Network Places.
► Enabling UPnP port forwarding allows the Network Camera to open a secondary HTTP port on the
router-not HTTP port-meaning that you have to add the secondary HTTP port number to the Network
Camera’s public address in order to access the Network Camera from the Internet. For example,
when the HTTP port is set to 80 and the secondary HTTP port is set to 8080, refer to the list below for
the Network Camera’s IP address.

► If the PPPoE settings are incorrectly configured or the Internet access is not working, restore the
Network Camera to factory default; please refer to Restore on page 83 for details. After the Network
Camera is reset to factory default, it will be accessible on the LAN.
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Enable IPv6

Select this option and click Save to enable IPv6 settings.
Please note that this only works if your network environment and hardware equipment support IPv6. The
browser should be Microsoft® Internet Explorer 6.5, Mozilla Firefox 3.0 or above.

When IPv6 is enabled, by default, the network camera will listen to router advertisements and be
assigned with a link-local IPv6 address accordingly.
IPv6 Information: Click this button to obtain the IPv6 information as shown below.

If your IPv6 settings are successful, the IPv6 address list will listed in the pop-up window. The IPv6
address will be displayed as follows:

Refers to Ethernet

Link-global IPv6 address/network mask
Link-local IPv6 address/network mask
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Please follow the steps below to link to an IPv6 address:
1. Open your web browser.
2. Enter the link-global or link-local IPv6 address in the address bar of your web browser.
3. The format should be:

4. Press Enter on the keyboard or click Refresh button to refresh the webpage.
For example:

NOTE
► If you have a Secondary HTTP port (the default value is 8080), you can also link to the webpage in
the following address format: (Please refer to HTTP on page 38 for detailed information.)

► If you choose PPPoE as the Network Type, the [PPP0 address] will show up in the IPv6 information
column as below.

Manually setup the IP address: Select this option to manually set up IPv6 settings if your network
environment does not have DHCPv6 server and router advertisements-enabled routers.
If you check this item, the following blanks will be displayed for you to enter the corresponding
information:
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HTTP Advanced Mode
To utilize HTTP authentication, make sure that your have set a password for the Network Camera first;
please refer to Security on page 26 for details.

Authentication: Depending on your network security requirements, the Network Camera provides two
types of security settings for an HTTP transaction: basic and digest.
If basic authentication is selected, the password is sent in plain text format and there can be potential
risks of being intercepted. If digest authentication is selected, user credentials are encrypted using MD5
algorithm and thus provide better protection against unauthorized accesses.
HTTP port / Secondary HTTP port: By default, the HTTP port is set to 80 and the secondary HTTP port is
set to 8080. They can also be assigned to another port number between 1025 and 65535. If the ports are
incorrectly assigned, the following warning messages will be displayed:

To access the Network Camera on the LAN, both the HTTP port and secondary HTTP port can be used
to access the Network Camera. For example, when the HTTP port is set to 80 and the secondary HTTP
port is set to 8080, refer to the list below for the Network Camera’s IP address.

Access name for stream 1 / Access name for stream 2: The access name is used to differentiate the
streaming source.
When using Mozilla Firefox or Netscape to access the Network Camera and the video mode is set to
JPEG, users will receive video comprised of continuous JPEG images. This technology, known as “server
push”, allows the Network Camera to feed live pictures to Mozilla Firefox and Netscape.
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URL command -- http://<ip address>:<http port>/<access name for stream1 or stream2>
For example, when the Access name for stream 2 is set to video2.mjpg:
1. Launch Mozilla Firefox or Netscape.
2. Type the URL command in the address bar. Press Enter.
3. The JPEG images will be displayed in your web browser.

NOTE
► Microsoft ® Internet Explorer does not support server push technology; therefore, using http://<ip
address>:<http port>/<access name for stream1 or stream2> will fail to access the Network Camera.

HTTPS

By default, the HTTPS port is set to 443. It can also be assigned to another port number between 1025
and 65535.

Two way audio

By default, the two way audio port is set to 5060. Also, it can also be assigned to another port number
between 1025 and 65535.
The Network Camera supports two way audio communication so that operators can transmit and receive
audio simultaneously. By using the Network Camera’s built-in or external microphone and an external
speaker, you can communicate with people around the Network Camera.
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Note that as JPEG only transmits a series of JPEG images to the client, to enable the two-way audio
function, make sure the video mode is set to “MPEG-4” on the Audio and Video Settings page and the
media option is set to “Video and Audio” on the Client Settings page. Please refer to Client Settings on
page 21 and Audio and Video Settings on page 51.

Click
to enable audio transmission to the Network Camera; click
to turn off the audio. To stop talking, click
again.
microphone; click

to adjust the volume of

FTP

The FTP server allows the user to save recorded video clips. You can utilize LevelOne Installation Wizard
2 to upgrade the firmware via FTP server. By default, the FTP port is set to 21. It also can be assigned to
another port number between 1025 and 65535.

52 - User's Manual

RTSP Streaming

To utilize RTSP streaming authentication, make sure that you have set a password for the Network
Camera first; please refer to Security on page 26 for details.

Authentication: Depending on your network security requirements, the Network Camera provides three
types of security settings for streaming via RTSP protocol: disable, basic, and digest.
If basic authentication is selected, the password is sent in plain text format, but there can be potential
risks of it being intercepted. If digest authentication is selected, user credentials are encrypted using
MD5 algorithm, thus providing better protection against unauthorized access.
The availability of the RTSP streaming for the three authentication modes is listed in the following table:
Disable
Basic
Digest

Quick Time player

Real Player

O
O
O

O
O
X

Access name for stream 1 / Access name for stream 2: This Network camera supports dual streams
simultaneously. The access name is used to differentiate the streaming source.
If you want to use an RTSP player to access the Network Camera, you have to set the video mode to
MPEG-4 and use the following RTSP URL command to request transmission of the streaming data.
rtsp://<ip address>:<rtsp port>/<access name for stream1 or stream2>
For example, when the access name for stream 1 is set to live.sdp:
1. Launch an RTSP player.
2. Choose File > Open URL. A URL dialog box will pop up.
3. Type the URL command in the text box. For example:
4. The live video will be displayed in your player as shown
below.
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RTSP port /RTP port for video, audio/ RTCP port for video, audio
■ RTSP (Real-Time Streaming Protocol) controls the delivery of streaming media. By default, the port
number is set to 554.
■ The RTP (Real-time Transport Protocol) is used to deliver video and audio data to the clients. By
default, the RTP port for video is set to 5556 and the RTP port for audio is set to 5558.
■ The RTCP (Real-time Transport Control Protocol) allows the Network Camera to transmit the data by
monitoring Internet traffic volume. By default, the RTCP port for video is set to 5557 and the RTCP port
for audio is set to 5559.
The ports can be changed to values between 1025 and 65535. The RTP port must be an even number
and the RTCP port is the RTP port number plus one, and thus is always odd. When the RTP port
changes, the RTCP port will change accordingly.
If the RTP ports are incorrectly assigned, the following warning message will be displayed:

Multicast settings for stream 1 / Multicast settings for stream 2: Click the items to display the detailed
configuration information. Select the Always multicast option to enable multicast for stream 1 or stream 2.

Unicast video transmission delivers a stream through point-to-point transmission; multicast, on the other
hand, sends a stream to the multicast group address and allows multiple clients to acquire the stream at
the same time by requesting a copy from the multicast group address. Therefore, enabling multicast can
effectively save Internet bandwith.
The ports can be changed to values between 1025 and 65535. The multicast RTP port must be an even
number and the multicast RTCP port number is the multicast RTP port number plus one, and is thus
always odd. When the multicast RTP port changes, the multicast RTCP port will change accordingly.
If the multicast RTP video ports are incorrectly assigned, the following warning message will be
displayed:

Multicast TTL [1~255]: The multicast TTL (Time To Live) is the value that tells the router the range a
packet can be forwarded.
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Wireless LAN (WCS-2040v3 only)

SSID (Service Set Identifier): This is the name that identifies a wireless network. Access Points and
wireless clients attempting to connect to a specific WLAN (Wireless Local Area Network) must use the
same SSID. The default setting is “default”. Note: The maximum length for an SSID is 32 single-byte
characters and cannot consist of “, <, >, or blank spaces.
Wireless mode: Click on the pull-down menu to select from the following options:
■ Infrastructure: Connect the Network Camera to the WLAN via an Access Point. (default setting)
■ Ad-Hoc: Connect the Network Camera directly to a host equipped with a wireless adapter in a peer-topeer environment.

Channel: While in infrastructure mode, the channel is selected automatically to match the channel setting
of the selected Access Point. In Ad-Hoc mode, the channel must be manually set to the same channel for
each wireless adapter. The default channel setting depends on the installed region.
TX rate: This field is for selecting the maximum transmission rate over the network. The default setting is
“auto”, that is, the Network Camera will try to connect to other wireless devices with highest transmission
rate.
Security: Select the data encrypt method. There are four types, including: none, WEP, WPA-PSK, and
WPA2-PSK.

1. None: No data encryption.
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2. WEP (Wired Equivalent Privacy): This allows communication only with other devices with identical
WEP settings.

■ Authentication Mode: Choose one of the following modes. The default setting is “Open”.
Open – Communicates the key across the network.
Shared – Allows communication only with other devices with identical WEP settings.

■ Key length: The administrator can set the key length to 64 or 128 bits.
The default setting is “64 bits”.

■ Key format: Hexadecimal or ASCII. The fault setting is “HEX”.

HEX digits consist of the numbers 0~9 and the letters A-F.
ASCII is a code for representing English letters as numbers from 0-127 except “, <, > , and the space
character which are reserved.

■ Network Key: Enter a key in either hexadecimal or ASCII format.

You can select different key lengths, the acceptable input lengths are as follows:
64-bit key length: 10 Hex digits or 5 characters.
128-bit key length: 26 Hex digits or 13 characters.

NOTE
► When 22(“), 3C(<), or 3E(>) are input as network keys, the key format cannot be changed to ASCII
format.
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3. WPA-PSK: Use WPA (Wi-Fi Protected Access) pre-shared key.

More secure than WEP, the Wi-Fi Alliance developed WPA (Wi-Fi Protected Access) in 2003 to
address WEP’s weaknesses. Improvements included TKIP, which changes the encryption key for each
data transmission.

■ Algorithm: Choose one of the following algorithms for WPA-PSK and WPA2-PSK modes.

TKIP (Temporal Key Integrity Protocol): A security protocol used in IEEE 802.11 wireless networks.
TKIP is a “wrapper” that goes around the existing WEP encryption. TKIP is comprised of the same
encryption engine and RC4 algorithm defined for WEP; however, the key used for encryption in TKIP
is 128 bits long. This solves the first problem of WEP: a short key length. (From Wikipedia)
AES (Advanced Encryption Standard): In cryptography, the Advanced Encryption Standard (AES), also
known as Rijndael, is a block cipher adopted as an encryption standard by the U.S. government.
As of 2006, AES is one of the most popular algorithms used in symmetric key cryptography. (From
Wikipedia)

■ Pre-shared Key: Enter a key in ASCII format. The length of the key can be between 8 to 63 characters.
4. WPA2-PSK: Use WPA2 pre-shared key.

This advanced protocol, certified through Wi-Fi Alliance’s WPA2 program, implements the mandatory
elements of 802.11i. In particular, it introduces a new AES-based algorithm, CCMP, that is considered
fully secure. From March 13, 2006, WPA2 certification is mandatory for all new devices wishing to be
certified by the Wi-Fi Alliance as “Wi-Fi CERTIFIED.” (From Wikipedia)

NOTE
► After wireless configurations are completed, click Save and the camera will reboot. Wait for the live
image ito be reloaded to your browser. For LevelOne 7000-series cameras, you have to unplug the
power and Ethernet cables from the camera; then re-plug the power cable to the camera. The camera
will switch to wireless mode.
► Some invalid settings may cause the system to fail to respond. Change the configuration settings only
if necessary and consult with your network supervisor or experienced users for correct settings. Once
the system has lost contact, please refer to Maintenance on page 83 for reset and restore procedures.
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DDNS
This section explains how to configure the dynamic domain name service for the Network
Camera. DDNS is a service that allows your Network Camera, especially when assigned with a
dynamic IP address, to have a fixed host and domain name.
DDNS: Dynamic domain name service

Enable DDNS: Select this option to enable the DDNS setting.
Provider: Select a DDNS provider from the provider drop-down list.
LevelOne offers Safe100.net, a free dynamic domain name service, to LevelOne customers. It is
recommended that you register Safe100.net to access LevelOne’s Network Cameras from the Internet.
Additionally, we offer other DDNS providers, such as Dyndns.org(Dynamic), Dyndns.org(Custom), TZO.
com, DHS.org, CustomSafe100, dyn-interfree.it.
Note that before utilizing this function, please apply for a dynamic domain account first.

■ Safe100.net

1. In the DDNS column, select Safe100.net from the drop-down list. Click I accept after reviewing the
terms of the Service Agreement.
2. In the Register column, fill in the Host name (xxxx.safe100.net), Email, Key, and Confirm Key, then
click Register. After a host name has been successfully created, a success message will be displayed
in the DDNS Registration Result column.

3. Click Copy and all the registered information will automatically be uploaded to the corresponding fields
in the DDNS column at the top of the page as seen in the picture.
58 - User's Manual

4. Select Enable DDNS and click Save to enable the setting.

■ CustomSafe100

LevelOne offers documents to establish a CustomSafe100 DDNS server for distributors and system
integrators. You can use CustomSafe100 to register a dynamic domain name if your distributor or system
integrators offer such services.
1. In the DDNS column, select CustomSafe100 from the drop-down list.
2. In the Register column, fill in the Host name, Email, Key, and Confirm Key; then click Register. After a
host name has been successfully created, you will see a success message in the DDNS Registration
Result column.
3. Click Copy and all for the registered information will be uploaded to the corresponding fields in the
DDNS column.
4. Select Enable DDNS and click Save to enable the setting.
Forget key: Click this button if you have forgotten the key to Safe100.net or CustomSafe100. Your
account information will be sent to your email address.

Refer to the following links to apply a dynamic domain account when selecting other DDNS
providers:

■ Dyndns.org(Dynamic) / Dyndns.org(Custom): visit http://www.dyndns.com/
■ TZO.com: visit http://www.tzo.com/
■ DHS.org: visit http://www.dhs.org/
■ dyn-interfree.it: visit http://dyn-interfree.it/
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Access List

Advanced Mode

This section explains how to control access permission by verifying the client PC’s IP address.
General Settings

Maximum number of concurrent streaming connection(s) limited to: Simultaneous live viewing for 1~10
clients (including stream 1 and stream 2). The default value is 10. If you modify the value and click Save,
all current connections will be disconnected and automatically attempt to re-link (IE Explore or Quick
Time Player).
View Information: Click this button to display the connection status window showing a list of the current
connections. For example:

■ IP address: Current connections to the Network Camera.
■ Elapsed time: How much time the client has been at the webpage.
■ User ID: If the administrator has set a password for the webpage, the clients have to enter a user name
and password to access the live video. The user name will be displayed in the User ID column. If the
administrator allows clients to link to the webpage without a user name and password, the User ID
column will be empty.
There are some situations which allow clients access to the live video without a user name and
password:
1. The administrator does not set up a root password. For more information about how to set up a root
password and manage user accounts, please refer to Security on page 26.
2. The administrator has set up a root password, but set RTSP Authentication to “disable“. For more
information about RTSP Authentication, please refer to RTSP Streaming on page 41.
3. The administrator has set up a root password, but allows anonymous viewing. For more information
about Allow Anonymous Viewing, please refer to Security on page 26.
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■ Refresh: Click this button to refresh all current connections.
■ Add to deny list: You can select entries from the Connection Status list and add them to the Deny List
to deny access. Please note that those checked connections will only be disconnected temporarily
and will automatically try to re-link again (IE Explore or Quick Time Player). If you want to enable the
denied list, please check Enable access list filtering and click Save in the first column.
■ Disconnect: If you want to break off the current connections, please select them and click this
button. Please note that those checked connections will only be disconnected temporarily and will
automatically try to re-link again (IE Explore or Quick Time Player).
Enable access list filtering: Check this item and click Save if you want to enable the access list filtering
function.

Filter

There are two lists for permission control: Allowed list and Denied list. Only those clients whose IP
addresses are on the Allowed list and not on the Denied list can access the Network Camera. Please
note that the IPv6 access list column will not be displayed unless you enable IPv6 on the Network page.
For more information about IPv6 Settings, please refer to page 36 for detailed information.

■ Add a rule to Allowed/Denied list: Click Add to add a rule to Allowed/Denied list.
There are three types of rules for user to set up:
Single: This rule allows the user to add an IP address to the Allowed/Denied list.
For example:
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Network: This rule allows the user to assign a network address and corresponding subnet mask to the
Allow/Deny List.
For example:

IP address 192.168.2.x will be bolcked.
Range: This rule allows the user to assign a range of IP addresses to the Allow/Deny List. This rule is
only applied to IPv4.
For example:

■ Delete Allowed/Denied list:
In the Delete Allowed List or Delete Denied List column, make a selection and click Delete.

NOTE
► For example, when the range of IP addresses in the allowed list is set from 1.1.1.0 to 192.255.255.255
and the range in the denied list is set from 1.1.1.0 to 170.255.255.255, only users’ IP located between
171.0.0.0 and 192.255.255.255 can access the Network Camera.

Administrator IP address

Always allow the IP address to access this device: You can check this item and add the Administrator’s
IP address in this field to make sure the Administrator can always connect to the device.
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Audio and Video
This section explains how to cofigure the audio and video settings of the Network Camera. It is
composed of the following two columns: Video Settings and Audio Settings.
Video Settings

Video title: Enter a name that will be displayed on the title bar of the live video.

Color: Select to display color or black/white video streams.
Power line frequency: Set the power line frequency consistent with local utility settings to eliminate image
flickering associated with fluorescent lights. Note that after the power line frequency is changed, you
must disconnect and reconnect the power cord of the Network Camera in order for the new setting to
take effect.
Video orientation: Flip--vertically reflect the display of the live video; Mirror--horizontally reflect the display
of the live video. Select both options if the Network Camera is installed upside-down (ex. on the ceiling)
to correct the image orientation.
Overlay title and time stamp on video: Select this option to place the video title and time on the video
streams.
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Note that when the frame size is set to 176 x 144 as shown in the picture below, only the time will be
stamped on the video streams.

Enable time shift caching stream Advanced Mode : Check this item to enable the time shift cache
stream on the Network Camera, which will stores video in the camera’s embedded memory for a period
of time depending on the cache memory of each Network Camera. This function can work seamlessly
with LevelOne’s IP CamSecure recording software. When an event occurs, the recording software can
request time shift cache stream from the camera, which allows the user to get an earlier video data.

Image Settings Advanced Mode
Click Image Settings to open the Image Settings page. On this page, you can tune the Brightness,
Saturation, Contrast, and Sharpness for the video.

Image Adjustment
■ Brightness: Adjust the image brightness level, which ranges from -5 to +5. The default value is set to 0.
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■ Saturation: Adjust the image saturation level, which ranges from -5 to +5. The default value is set to 0.
■ Contrast: Adjust the image contrast level, which ranges from -5 to +5. The default value is set to 0.
■ Sharpness: Adjust the image sharpness level, which ranges from -3 to +3. The default value is set to +3.
You can click Preview to fine-tune the image, or click Restore to recall the original settings without
incorporating the changes. When completed with the settings on this page, click Save to enable the
setting and click Close to exit the page.

CCD Adjustment Advanced Mode
Click CCD settings to open the CCD Adjustment page. On this page, you can set the Auto electronic
shutter (AES), Auto tracking white balance, White balance control, Low lux mode, and BLC settings.

Auto electronic shutter (AES): The default iris setting of the CCD is fixed mode, and the AES option
will be 1/50 (1/60). There are several options for AES: 1/50 (1/60), 1/100 (1/120), 1/250, 1/500, 1/1000,
1/200, and 1/4000. Faster electronic shutter would enable the Network Camera to capture fast-moving
objects more clearly. Once the shutter is selected as Auto, the iris of the CCD will become fixed.
Auto tracking white balance: This option is usually selected when the Network Camera is placed in
outdoor environments. Adjusting the 0~8 level would help the Network Camera capturing video with
correct colors. The default value is set to 4.
White balance control: Select this option will disable Auto tracking white balance. This option is usually
selected when the Network Camera is placed in indoor environments. The administrator can adjust the
value for best color temperature: 3200k, 4000k, 4800k, 5600k, 6400k, 7200k, 8000k.
Low lux mode: Select this option would enable the Network Camera to capture clear images in poor
illuminative environments.
Auto switch to B/W in low lux mode: Select it to enable the Network Camera to automatically switch to B/
W in low lux mode.
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Enable BLC (Back Light Compensation): Select it when the object is too dark or too bright to be
recognized. It will give the captured images the necessary light compensation.
BLC sens level: Select 0~7 level to adjust the sensitivity of BLC detection. Select a higher level will raise
the sensitivity. The default value is set to 3.
BLC area selection: Click this button to open an area selection window. As the window shown below, the
video will be divided into 48 rectangle areas equally. Check some of the areas to enable BLC. Note that if
no area is selected, the Enable BLC option would be of no use.
The picture below illustrates the corresponding areas of the selection window. You can click Select All to
check all the areas in the window, or click Clear All to do vice versa. When completed with the settings
on this page, click Save to take effect and click Close to exit the page.

Back to the CCD Settings page, you can click Preview to fine-tune the image, or click Restore to recall
the original settings without incorporating the changes. When completed with the settings on this page,
click Save to take effect and click Close to exit the page.

Video quality settings for stream 1 / stream 2 Advanced Mode
The Network Camera offers two choices of video compression standards for real-time viewing: MPEG-4
and MJPEG.
Click the items to display the detailed configuration settings. You can set up two seperate streams for the
Network Camera for different viewing devices. For example, set a smaller frame size and lower bit rate
for remote viewing on mobile phones and a larger video size and a higher bit rate for live viewing on web
browsers.
If MPEG-4 mode is selected, it is streamed in RTSP protocol.

66 - User's Manual

There are four parameters provided in MPEG-4 mode which allow you to adjust the video performance:
■ Frame size
Select the video size. Note that a larger frame size takes up more bandwidth. The frame sizes are
selectable in the following resolutions:

CIF
QCIF

NTSC
704 x 480
352 x 240
176 x 120

PAL
704 x 576
352 x 288
176 x 144

■ Maximum frame rate
This limits the maximal refresh frame rate per second. Set the frame rate higher for a smoother video
quality. The frame rates are selectable at 1fps, 2fps, 3fps, 5fps, 8fps, 10fps, 15fps, 20fps, 25fps, and
30fps. You can also select Customize and manually enter a value.
■ Intra frame period
Determine how often to plant an I frame. The shorter the duration, the more likely you will get better
video quality, but at the cost of higher network bandwidth consumption. Select the intra frame period
from the following durations: 1/4 second, 1/2 second, 1 second, 2 seconds, 3 seconds, and 4 seconds.
■ Video quality
A complex scene generally produces a larger file size, meaning that higher bandwidth will be needed
for data transmission. Therefore, if Constant bit rate is selected, the bandwidth utilization is fixed at
a selected level, resulting in mutable video quality performance. The bit rates are selectable at the
following rates: 20Kbps, 30Kbps, 40Kbps, 50Kbps, 64Kbps, 128Kbps, 256Kbps, 512Kbps, 768Kbps,
1Mbps, 2Mbps, 3Mbps, and 4Mbps. You can also select Customize and manually enter a value.
On the other hand, if Fixed quality is selected, all frames are transmitted with the same quality;
bandwidth utilization is therefore unpredictable. The video quality can be adjusted to the following
settings: Medium, Standard, Good, Detailed, and Excellent. You can also select Customize and
manually enter a value.
If JPEG mode is selected, the Network Camera continuously sends JPEG images to the client, producing
a moving effect similar to a filmstrip. Every single JPEG image transmitted guarantees the same image
quality, which in turn comes at the expense of variable bandwidth usage. Because the media contents
are a combination of JPEG images, no audio data is transmitted to the client.

There are three parameters provided in MJPEG mode to control the video performance:
■ Frame size
Select the video size. Note that a larger frame size takes up more bandwidth. The frame sizes are
selectable in the following resolutions:

CIF
QCIF

NTSC
704 x 480
352 x 240
176 x 120

PAL
704 x 576
352 x 288
176 x 144
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■ Maximum frame rate
This limits the maximum refresh frame rate per second. Set the frame rate higher for smoother video
quality. The frame rates are selectable at 1fps, 2fps, 3fps, 5fps, 8fps, 10fps, 15fps, 20fps, 25fps, and
30fps. You can also select Customize and manually enter a value.
■ Video quality
The video quality can be adjusted to the following settings: Medium, Standard, Good, Detailed, and
Excellent. You can also select Customize and manually enter a value.

NOTE
► Video quality and fixed quality refers to the compression rate, so a lower value will produce higher
quality.

Audio Settings

Mute: Select this option to disable audio transmission from the Network Camera to all clients. Note that
if mute mode is turned on, no audio data will be transmitted even if audio transmission is enabled on the
Client Settings page. In that case, the following message is displayed:

Internal microphone input gain: Select the gain of the internal audio input according to ambient
conditions. Adjust the gain from +21 db (most sensitive) ~ -33 db (least sensitive).
External microphone input: Select the gain of the external audio input according to ambient conditions.
Adjust the gain from +21 db (most sensitive) ~ -33 db (least sensitive).
AAudio type: Select audio codec AAC or GSM-AMR and the bit rate.
■ AAC provides good sound quality at the cost of higher bandwidth consumption. The bit rates are
selectable from: 16Kbps, 32Kbps, 48Kbps, 64Kbps, 96Kbps, and 128Kbps.
■ GSM-ARM is designed to optimize speech quality and requires less bandwidth. The bit rates are
selectable from: 4.75Kbps, 5.15Kbps, 5.90Kbps, 6.7Kbps, 7.4Kbps, 7.95Kbps, 10.2Kbps, and
12.2Kbps.
When completed with the settings on this page, click Save to enable the settings.

NOTE
► The Network Camera offers two inputs to capture audio - internal microphone or external microphone.
The internal/external microphone switch is located on the back panel of the Network Camera.
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Motion Detection
This section explains how to configure the Network Camera to enable motion detection. A total
of three motion detection windows can be configured.

Follow the steps below to enable motion detection:
1. Click New to add a new motion detection window.
2. In the Window Name text box, enter a name for the motion detection window.
■ To move and resize the window, drag and drop your mouse on the window.
■ To delete window, click X on the top right corner of the window.
3. Define the sensitivity to moving objects and the space ratio of all alerted pixels by moving the
Sensitivity and Percentage slider bar.
4. Click Save to enable the settings.
5. Select Enable motion detection to enable this function.

For example:

The Percentage Indicator will rise or fall depending on the variation between sequential images. When
motions are detected by the Network Camera and are judged to exceed the defined threshold, the
red bar rises. Meanwhile, the motion detection window will be outlined in red. Photos or videos can be
captured instantly and configured to be sent to a remote server (Email, FTP) by utilizing this feature as a
trigger source. For more information on how to set an event, please refer to Application on page 65.
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A green bar indicates that even though motions have been detected, the event has not been triggered
because the image variations still fall under the defined threshold.

NOTE
► How does motion detection work?

There are two motion detection parameters: Sensitivity and Percentage. In the illustration above,
frame A and frame B are two sequential images. Pixel differences between the two frames are
detected and highlighted in gray (frame C) and will be compared with the sensitivity setting. Sensitivity
is a value that expresses the sensitivity to moving objects. Higher sensitivity settings are expected to
detect slight movements while smaller sensitivity settings will neglect them. When the sensitivity is set
to 70%, the Network Camera defines the pixels in the purple areas as “alerted pixels” (frame D).
Percentage is a value that expresses the proportion of “alerted pixels” to all pixels in the motion
detection window. In this case, 50% of pixels are identified as “alerted pixels”. When the percentage is
set to 30%, the motions are judged to exceed the defined threshold; therefore, the motion window will
be outlined in red.
For applications that require a high level of security management, it is suggested to use higher
sensitivity settings and smaller percentage values.
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Camera Control
This section explains how to control the Network Camera’s Pan/Tilt/Zoom/Focus operation via
the control panel and how to preset positions.
Preset Locations

On this page, you can preset positions for the Network Camerato go to directly or patrol. A total of 128
preset positions can be configured.
Please follow the steps below to preset a position:
1. Adjust the shooting area to a desired position using the buttons on the right side of the window.
2. Click Set as home or Default home to define your home position.
3. Enter a name for the preset position, which allows for up to forty characters. Click Add to enable the
settings. The preset positions will be displayed under the Preset Location list on the left-hand side.
4. To add additional preset positions, please repeat step 1~3.
5. To remove a preset position from the list, select it from the drop-down list and click Delete.
6. Click Save to enable the settings.

1 functions are the same

as the control panel on
home page

3
2
3
5

6
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Patrol Settings

You can select preset locations for the Network Camera to patrol.
Please follow the steps below to set up a patrol schedule:
1. Click a preset location on the list and click Select.
2. The selected preset locations will be displayed on the Selected locations list.
3. Set the Dwelling time for the preset location during auto patrol. The default value is 10 seconds. You
can also manually set a value and click Update.
4. Repeat step 1 and 3 to select additional preset locations.
5. If you want to delete a selected location, select it from the list and click Remove.
6. Select a location and click Up or Down to rearrange the patrol order.
7. Adjust the Auto pan/patrol speed. (1~5 seconds)
8. Click Save to enable the settings.

7

1
2

5
6
8

72 - User's Manual

3

Digital Zoom

If you check this optionand click the Save button, the digital zoom function of CCD module will be
enabled.

Zoom Times Display

If you check this item and click the Save button, the zoom indicator will be displayed on the screen when
you zoom in/out as shown in the illustration above. Please remember to click Save to enable the settings.

Return to Home Position while Idle

If you select this option, the Network Camera will automatically return to the home position after idling for
a specific time span. Please remember to click Save to enable the settings.
■ The Preset Locations will be displayed on the Home page:

■ Click Go to: The Network Camera will move to the preset location.
■ Click Patrol: The Network Camera will patrol among the selected preset positions (from right to left) for
once.
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Homepage Layout

Advanced Mode

This section explains how to set up your own customized homepage layout.
Preview

This column shows the settings of your homepage layout. You can manually select the background and
font colors in Theme Options, the third column on this page. The settings will automatically show up in
this Preview field. The following shows the homepage using the default settings:

■ Hide Powered by LevelOne: If you check this item, it will be removed from the homepage.

Logo

Here you can change the logo at the top of your homepage.

Follow the steps below to upload a new logo:
1. Click Custom and the Browse field will appear.
2. Select a logo from your files.
3. Click Upload to replace the existing logo with a new one.
4. Enter a website link if necessary.
5. Click Save to enable the settings.
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Theme Options

Here you can change the color of your homepage layout. There are three types of preset patterns for you
to choose from. The new layout will simultaneously appear in the Preview filed. Click Save to enable the
settings.

Preset Patterns
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■ Follow the steps below to set up the customed homepage:
1. Click Custom on the left column.
2. Click the field where you want to change the color on the right column.

Color Selector

Custom
Pattern
3. The palette window will pop up as shown below.

4. Drag the slider bar and click on the left square to select a desired color.
5. The selected color will show up in the corresponding fields and in the Preview column.
6. Click Save to enable the settings.

76 - User's Manual

Application

Advanced Mode

This section explains how to configure the Network Camera to react in response to particular
situations (event). A typical application is that when a motion is detected, the Network Camera
sends buffered images to a FTP server or e-mail address as notifications.
In the illustration on the right, an event can be triggered
by many sources, such as motion detection or external
digital input devices. When an event is triggered, you
can specify what type of action that will be performed.
You can configure the Network Camera to send
snapshots or videos to your email address or FTP site.

Customized Script

This function allows you to upload a sample script (.xml file) to the webpage, which will save your time on
configuring the settings. Please note that there is a limited number of customized scripts you can upload;
if the current amount of customized scripts has reached the limit, an alert message will pop up. If you
need more information, please ask for LevelOne’s technical support.

Click to upload a file

Click to modify the
script online
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Event Settings

In the Event Settings column, click Add to open the Event Settings page. On this page, you can
arrange three elements -- Trigger, Schedule, and Action to set an event. A total of 3 event settings can be
configured.

Event name: Enter a name for the event setting.
Enable this event: Select this option to enable the event setting.
Priority: Select the relative importance of this event (High, Normal, or Low). Events with a higher priority
setting will be executed first.
Detect next event after
motion is detected.
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seconds: Enter the duration in seconds to pause motion detection after a

An event is an action initiated by a user-defined trigger source; it is the causal arrangement of the
following three elements: Trigger, Event Schedule, and Action.
Trigger
This is the cause or stimulus which defines when to trigger the Network Camera. The trigger source can
be configured to use the Network Camera’s built-in motion detection mechanism or external digital input
devices.
There are several choices of trigger sources as shown below. Select the items to display the detailed
configuration options.
■ Video motion detection
This option makes use of the built-in motion detection mechanism as a trigger source. To enable this
function, you need to configure a Motion Detection Window first. For more information, please refer to
Motion Detection on page 57 for details.

■ Periodically
This option allows the Network Camera to trigger periodically for every other defined minute. Up to 999
minutes are allowed.

■ Digital input
This option allows the Network Camera to use an external digital input device or sensor as a trigger
source. Depending on your application, there are many choices of digital input devices on the market
which helps to detect changes in temperature, vibration, sound and light, etc.
■ System boot
This option triggers the Network Camera when the power to the Network Camera is disconnected.
■ Recording notify
This option allows the Network Camera to trigger when the recording disk is full or when recording
starts to rewrite older data. If you want receive Recording notify message, please refer to page 76
for detailed information.
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Event Schedule
Specify the period for the event.

■ Select the days of the week.
■ Select the recording schedule in 24-hr time format.
Action
Define the actions to be performed by the Network Camera when a trigger is activated.

■ Trigger digital output for seconds
Select this option to turn on the external digital output device when a trigger is activated. Specify the
length of the trigger interval in the text box.
■ Move to preset location
Select this option, the Network Camera will move to the preset location when a trigger is activated.
Please setup the preset locations first. Please refer to Preset Locations on page 59 for detailed
information.

To set an event with recorded video or snapshots, it is necessary to configure the server and
media settings so that the Network Camera will know what action to take (such as which server
to send the media files to) when a trigger is activated.
■ Add Server / Add Media

Click Add Server to configure Server Settings. For more information, please refer to Server Settings
on page 71.
Click Add Media to configure Media Settings. For more information, please refer to Media Settings on
page 74.

80 - User's Manual

Here is an example of Event Settings page:

When completed, click Save to enable the settings and click Close to exit Event Settings page. The new
event settings / server settings / media settings will appear in the event drop-down list on the Application
page.
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Here is an example of Application page with an event setting:

When the Event Status is ON, once an event is triggered by motion detection, the Network Camera will
automatically send snapshots via e-mail.
If you want to stop the event trigger, you can click ON to turn it to OFF status or click Delete to remove
the event setting.
To remove a server setting from the list, select a server name from the drop-down list and click Delete.
Note that only when the server setting is not being applied to an event setting can it be deleted.
To remove a media setting from the list, select a media name from the drop-down list and click Delete.
Note that only when the media setting is not being applied to an event setting can it be deleted.
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Server Settings

Click Add Server on Event Settings page to open the Server Setting page. On this page, you can specify
where the notification messages are sent when a trigger is activated. A total of 5 server settings can be
configured.
Server name: Enter a name for the server setting.
Server Type
There are four choices of server types available: Email, FTP, HTTP, and Network storage. Select the item
to display the detailed configuration options. You can configure either one or all of them.
Email: Select to send the media files via email when a trigger is activated.

■ Sender email address: Enter the email address of the sender.
■ Recipient email address: Enter the email address of the recipient.
■ Server address: Enter the domain name or IP address of the email server.
■ User name: Enter the user name of the email account if necessary.
■ Password: Enter the password of the email account if necessary.
■ Server port: The default mail server port is set to 25. You can also manually set another port.
If your SMTP server requires a secure connection (SSL), check This server requires a secure
connection (SSL).
To verify if the email settings are correctly configured, click Test. The result will be shown in a pop-up
window. If successful, you will also receive an email indicating the result.

Click Save to enable the settings, then click Close to exit the page.
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FTP: Select to send the media files to an FTP server when a trigger is activated.

■ Server address: Enter the domain name or IP address of the FTP server.
■ Server port
By default, the FTP server port is set to 21. It can also be assigned to another port number between
1025 and 65535.
■ User name: Enter the login name of the FTP account.
■ Password: Enter the password of the FTP account.
■ Remote folder name
Enter the folder where the media file will be placed. If the folder name does not exist, the Network
Camera will create one on the FTP server.
■ Passive mode
Most firewalls do not accept new connections initiated from external requests. If the FTP server
supports passive mode, select this option to enable passive mode FTP and allow data transmission to
pass through the firewall.
To verify if the FTP settings are correctly configured, click Test. The result will be shown in a pop-up
window as shown below. If successful, you will also receive a test.txt file on the FTP server.

Click Save to enable the settings, then click Close to exit the page.
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HTTP: Select to send the media files to an HTTP server when a trigger is activated.

■ URL: Enter the URL of the HTTP server.
■ User name: Enter the user name if necessary.
■ Password: Enter the password if necessary.
To verify if the HTTP settings are correctly configured, click Test. The result will be shown in a pop-up
window as below. If successful, you will receive a test.txt file on the HTTP server.

Click Save to enable the settings, then click Close to exit the page.
Network storage: Select to send the media files to a network storage location when a trigger is activated.
Please refer to Network Storage Setting on page 78 for details.
Click Save to enable the settings, then click Close to exit the page.
When completed, the new server settings will automatically be displayed on the Event Settings page.
For example:
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Media Settings

Click Add Media on the Event Settings page to open the Media Settings page. On this page, you can
specify the type of media that will be sent when a trigger is activated. A total of 5 media settings can be
configured.
Media name: Enter a name for the media setting.
Media Type
There are three choices of media types available: Snapshot, Video clip, and System log. Select the item
to display the detailed configuration options. You can configure either one or all of them.
Snapshot: Select to send snapshots when a trigger is activated.

■ Source: Select to take snapshots from stream 1 or stream 2.
■ Send pre-event images
The Network Camera has a buffer area; it temporarily holds data up to a certain limit. Enter a number
to decide how many images to capture before a trigger is activated. Up to 7 images can be generated.
■ Send post-event images
Enter a number to decide how many images to capture after a trigger is activated. Up to 7 images can
be generated.
For example, if both the Send pre-event images and Send post-event images are set to 7, a total of 15
images are generated after a trigger is activated.

■ File name prefix
Enter the text that will be appended to the front of the file name.
■ Add date and time suffix to the file name
Select this option to add a date/time suffix to the file name.
For example:

Click Save to enable the settings, then click Close to exit the page.
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Video clip: Select to send video clips when a trigger is activated.

■ Source: Select to record video clips from stream 1 or stream 2.
■ Pre-event recording
The Network Camera has a buffer area; it temporarily holds data up to a certain limit. Enter a number
to decide the duration of recording before a trigger is activated. Up to 9 seconds can be set.
■ Maximum duration
Specify the maximum recording duration in seconds. Up to 10 seconds can be set.
For example, if pre-event recording is set to five seconds and the maximum duration is set to ten
seconds, the Network Camera continues to record for another 4 seconds after a trigger is activated.

■ Maximum file size
Specify the maximum file size allowed.
■ File name prefix
Enter the text that will appended to the front of the file name.
For example:

Click Save to enable the settings, then click Close to exit the page.
System log: Select to send a system log when a trigger is activated.
Click Save to enable the settings, then click Close to exit the page.
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Recording notify message: Select to send a recording notification message when a trigger is activated.
The following is an example of a recording notification message (.txt file), which shows a list of deleted
previously-recorded data due to cycle recording.

When completed, click Save to enable the settings and click Close to exit this page. The new media
settings will appear on the Event Settings page.
You can continue to select a server and media type for the event.

■ Create folders by date, time, and hour automatically: If you check this item, the system will generate
folders automatically by date.
■ View: Click this button to open a file list window. This function is only for Network Storage.
The following is an example of a file destination with video clips:
The format is: YYYYMMDD
Click to open the directory

Click to delete selected items

88 - User's Manual

Click to delete all recorded data

Click 20081120 to open the directory:
The format is: HH (24r)
Click to open the file list for that hour

Click to go back to the previous
level of the directory

Click to delete
selected items
Click to delete all
recorded data

The format is: File name prefix + Minute (mm)
You can set up the file name prefix on Media Settings page.
Please refer to page 74 for detailed information.
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Recording

Advanced Mode

This section explains how to configure the recording settings for the Network Camera.
Recording Settings

NOTE
► Before setting up this page, please set up the Network Storage on the Server Settings page first.
Network Storage Setting
Click Server to open the Server Settings page and follow the steps below to set up:
1. Fill in the information for your server.
For example:

2. Click Test to check the setting. The result will be shown in the pop-up window.
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If successful, you will receive a test.txt file on the network storage server.

3. Enter a server name.
4. Click Save to complete the settings and click Close to exit the page.
Recording Settings
Click Add to open the recording setting page. On this page, you can define the recording source,
recording schedule and recording capacity. A total of 2 recording settings can be configured.

Recording name: Enter a name for the recording setting.
Enable this recording: Select this option to enable video recording.
Priority: Select the relative importance of the recording setting (High, Normal, and Low).
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Source: Select the recording source (stream 1 or stream 2).
Recording Schedule: Specify the recording duration.
■ Select the days of the week.
■ Select the recording start and end times in 24-hr time format.
Destination: You can select the network storage to store the recorded video files.
Capacity: You can choose either the “entire free space available” or “limit the recording size”. The
recording size limit must be larger than the reserved amount for cyclic recording.
File name prefix: Enter the text that will be appended to the front of the file name.
Enable cyclic recording: If you check this item, when the maximum capacity is reached, the oldest file
will be overwritten by the latest one. The reserved amount is reserved for cyclic recording to prevent
malfunction. This value must be larger than 15 MBytes.
If you want to enable recording notification, please click Application to set up. Please refer to Trigger >
Recording notify on page 67 for detailed information.
When completed, select Enable this recording. Click Save to enable the setting and click Close to exit
this page. When the system begins recording, it will send the recorded files to the Network Storage.
The new recording name will appear in the drop-down list on the recording page as shown below.
To remove a recording setting from the list, select a recording name from the drop-down list and click
Delete.

■ Click Video (Name): Opens the Recording Settings page to modify.
■ Click ON (Status): The Status will become OFF and stop recording.
■ Click NAS (Destination): Opens the file list of recordings as shown below. For more information about
folder naming rule, please refer to page 77 for details.

92 - User's Manual

System Log

Advanced Mode

This section explains how to configure the Network Camera to send the system log to the
remote server as backup.
Remote Log

You can configure the Network Camera to send the system log file to a remote server as a log backup.
Before utilizing this feature, it is suggested that the user install a log-recording tool to receive system log
messages from the Network Camera. An example is Kiwi Syslog Daemon. Visit http://www.kiwisyslog.
com/kiwi-syslog-daemon-overview/.

Follow the steps below to set up the remote log:
1. In the IP address text box, enter the IP address of the remote server.
2. In the port text box, enter the port number of the remote server.
3. When completed, select Enable remote log and click Save to enable the setting.

Current Log

This column displays the system log in chronological order. The system log is stored in the Network
Camera’s buffer area and will be overwritten when reaching a maximum limit.
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View Parameters

Advanced Mode

The View Parameters page lists the entire system’s parameters in alphabetical order. If you
need technical assistance, please provide the information listed on this page.
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Maintenance
This chapter explains how to restore the Network Camera to factory default, upgrade firmware
version, etc.
Reboot

This feature allows you to reboot the Network Camera, which takes about one minute to complete. When
completed, the live video page will be displayed in your browser. The following message will be displayed
during the rebooting process.

If the connection fails after rebooting, manually enter the IP address of the Network Camera in the
address field to resume the connection.

Restore

This feature allows you to restore the Network Camera to factory default settings.
Network Type: Select this option to retain the Network Type settings. (Please refer to Network Type on
page 32.)
Daylight Saving Time: Select this option to retain the Daylight Saving Time settings. (Please refer to
System on page 24.)
Custom Language: Select this option to retain the Custom Language settings.
If none of the options is selected, all settings will be restored to factory default.
The following message is displayed during the restoring process.

Calibrate

This feature re-calibrate the home position to the default center to recover the any displacement caused
by external forces. Please note that there is no confirm message box after clicking on Calibrate, and the
Network Camera will calibrate immediately.
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Export / Upload Files Advanced Mode
This feature allows you to Export / Upload daylight saving time rules, custom language files, and setting
backup files.

Export daylight saving time configuration file: Click to set the start and end time of DST.
Follow the steps below to export:
1. In the Export files column, click Export to export the daylight saving time configuration file from the
Network Camera.
2. A file download dialog will pop up as shown below. Click Open to review the XML file or click Save to
store the file for editing.

3. Open the file with Microsoft® Notepad and locate your time zone; set the start and end time of DST.
When completed, save the file.
In the example below, DST begins each year at 2:00 a.m. on the second Sunday in March and ends at
2:00 a.m. on the first Sunday in November.
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Upload daylight saving time rule: Click Browse… and specify the XML file to upload.
If the incorrect date and time are assigned, you will see the following warning message when uploading
the file to the Network Camera.

The following message is displayed when attempting to upload an incorrect file format.

Export language file: Click to export language strings. LevelOne provides nine languages: English,
Deutsch, Español, Français, Italiano, 日本語, Português, 簡体中文, and 繁體中文.
Upload custom language file: Click Browse… and specify your own custom language file to upload.
Export setting backup file: Click to export all parameters for the device and user-defined scripts.
Upload setting backup file: Click Browse… to upload a setting backup file. Please note that the model
and firmware version of the device should be the same as the setting backup file. If you have set up a
fixed IP or other special settings for your device, it is not suggested to upload a settings backup file.

Upgrade Firmware

This feature allows you to upgrade the firmware of your Network Camera. It takes a few minutes to
complete the process.
Note: Do do not power off the Network Camera during the upgrade!
Follow the steps below to upgrade the firmware:
1. Download the latest firmware file from the LevelOne website. The file is in .pkg file format.
2. Click Browse… and specify the firmware file.
3. Click Upgrade. The Network Camera starts to upgrade and will reboot automatically when the upgrade
completes.
If the upgrade is successful, you will see “Reboot system now!! This connection will close”. After that, reaccess the Network Camera.
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The following message is displayed when the upgrade has succeeded.

The following message is displayed when you have selected an incorrect firmware file.
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